http://www.tpcug.org

Bits of
Blue

August in Tampa

A Monthly Publication of the Tampa PC Users Group, Inc.
Vol. 20 No. 8

August 2007

Meeting

Meeting Preview: Mytu Tran (pronounced Metoo), the
Business Services Sales Representative with CompUSA on
Hillsborough Ave., will tell us about the services they provide
to the home PC user and their current line of PC related products. As usual, the meeting will begin with our Windows SIG
led by Bob LaFave.

A visit from
CompUSA
Mytu Tran
Wednesday, August 8, 2007
6:30 PM
Art Pepin Hospitality Room
Pepin Distributing Co.
4121 N 50th St
Tampa, Florida

Editor’s Comments
By William LaMartin, Editor, Tampa PC Users Group
lamartin@tampabay.rr.com
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What to write about? I have had the new Adobe Photoshop
CS3 for several months. I have had the new Microsoft Office
2007 Ultimate for less than a month. Photoshop CS3 was a
two version upgrade from my previous Photoshop CS. Office
2007 is the next upgrade from my previous Office 2003.
However, the Ultimate version has several more programs
than did Office 2003 Professional: OneNote, InfoPath and
Groove. I won’t be using Groove since is for collaborative
work among a group of people, but InfoPath and OneNote
might be of some interest. Then there are the usual suspects
of Microsoft Word, Excel, Outlook, PowerPoint, Publisher
and Access, all of which I use. The problem of doing a re(Comments……….Continued on page 8)

September Meeting: To be announced
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Bits of Blue is published by the Tampa PC Users Group, Inc., a State of
Florida registered non-profit corporation, to provide educational information about
personal computer systems to its members. Our mailing address is P. O. Box
3492, Tampa, FL 33601-3492.
However, for business concerning this newsletter, Bits of Blue, please
contact the Editor, William LaMartin, at 821 S. Boulevard, Tampa, FL 336062904; 813-251-3817; lamartin@tampabay.rr.com.
Technical information found in this publication is not necessarily
compatible with your hardware and software, plus other errors or misprints could
occur from time to time. Therefore, the use of programs, commands, functions or
anything of a technical nature appearing in this publication will be at your own
risk.

RENEWING YOUR MEMBERSHIP?
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TAMPA PC USERS GROUP
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About Us | Join link to join or renew online
Check the address label for your renewal month
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Minutes of the July Meeting
By John Witmer, President, substituting for
Doug Mullis, Secretary, Tampa PC Users Group
dmullis@tampabay.rr.com
The meeting began with the Windows SIG led by Bob
LaFave. Bob stressed the importance of periodically
doing a Disk Cleanup. This utility can be found by
clicking on Start, | select All Programs | Accessories |
System Tools. Both Disk Cleanup and Disk Defragmenter can be found there. On the More Options tab of
Disk Cleanup, there are several additional options that
can be selected to free up additional disk space. Disk
Defragmenter is another utility found there that should
be periodically used to help speed up your system accessing the files and data stored on your hard drive.
Bob next took us on a trip down memory lane, bringing
up Windows 3.1 in a Virtual PC environment, giving us
a flashback to how the old days looked and functioned,
including use of the old File Manager, etc. Following
this flashback, discussion took place on the benefit of
disabling and getting rid of the Language Toolbar, if
you don’t need it for any reason. This program uses
resources to monitor for microphone input and is not
necessary if you don’t have or use a microphone to
capture speech.
A question was asked about monitor resolutions. The
response was that your video card and video memory
determine what resolutions are available to you; you
must also have the correct drivers installed to match the
video card. A comment on a different topic had to do
with removal of old security programs before installing
new ones. If you are unable to uninstall a Symantec
problem application that does not respond when you
use the add/remove programs approach, you can find a
Removal Tool that removes everything that Symantec
ever created. This tool is available on their website.
This concluded the Windows SIG portion of the meeting.
(Minutes……….Continued on page 7)

We acknowledge the following for their support
Marshall & Stevens
Pepin Distributing Co.
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Microsoft Office 2007:
My First Impressions
By William LaMartin, Editor,
Tampa PC Users Group
lamartin@tampabay.rr.com
The first thing I noticed when saving this document
I am writing in Word 2007 is that there is now a new
Word document type. It has a suffix of docx instead
of doc. Docx is the extension of the new file format
based on XML. Microsoft lists several benefits of
this format over the old format:
• More compact files: It uses zip compression to
compress and decompress on the fly.
• Improved damaged-file recovery: The modular
construction of the file allows it to be opened if
one component of the file is damaged but others
are OK.
• Better privacy: You can use “Document Inspector” to remove hidden data and personal information.
• Easier detection of documents containing macros: Office 2007 Word (.docx), Excel (.xlsx)
and PowerPoint (.pptx) files cannot contain
macros or VBA code. Only files ending in m
like .docm, .xlsm, and .pptm can contain such
code.
Of course, you can still save documents in the formats of earlier versions of Office. Additionally,
someone using an earlier version of Office, e.g., Office 2003, can open, edit some items, and save Office 2007 Word, Excel and PowerPoint documents
by using the Compatibility Pack for the 2007 Office
system, from Office 2003. The Office Compatibility
Pack for Office 2007 is available at the Microsoft
Download Center.
Access has a new file format, also. The suffix for
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that is accdb. As above, you can convert the new file
format to the earlier mdb file format if your Access
2007 database does not use any of the new features
in Access 2007. Things get quite technical when discussing the reasons to use or not use the new Access
file format, so I will not venture there.
I had no trouble installing the full version (not an
upgrade) of Office 2007 on both my desktop computer and my laptop, both of which had Windows XP
as the operating system and also had Office 2003
Professional installed. I chose to leave Office 2003
Professional installed and to install Office 2007 Ultimate in a separate folder. The reason for doing this is
that two individuals had warned me that I might find
a time when I needed to use the older version for
something. So far that need has not occurred, but, of
course, I have done very little with the new product
so far. I should note that you are allowed to install
the product on a desktop computer and a laptop computer simultaneously.
Word was the first program I started after the installation, and I was a bit disorientated by what I saw at
the top of the screen. Things are not where they used
to be. As you will note, there are no File or Edit
menu items in the image above. Instead, what you
see is called a Ribbon, with different tabs and each
tab divided into separate sections.
To get to your file options, you need to click on that
large round button in the upper left-hand corner. The
usual Edit options of Copy, Paste, etc. are right in
front of you on the Clipboard section of the Home
tab. If you need to insert something such as a picture, you would click on the Insert tab, where you
would be presented with a Ribbon containing a
Pages section, a Tables section, an Illustrations section, etc. The Illustrations section is the one containing a picture icon to be clicked on to start the inser(Office……….Continued on page 4)
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(Office……….Continued from page 3)

tion of an image.
The Page Layout ribbon tab looks like the second
image, above.
I think the Themes section is something that is new
with 2007 (I never saw it in 2003). Of course, the
other settings for Margins, Orientation, etc. are the
same as before. A check shows me that I am using
what is termed the Office Theme in writing this in
Word. There is a selection of 20 different themes
available, and, as I hover my mouse over any one,
my document immediately displays according to that
theme’s colors, fonts and effects.
Times New Roman is no longer the default font for
body text. It is now Calibri if I am using the Office
Theme, as you can see in the first graphic for this
article.
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Excel also has a new interface with a Ribbon, like
Word. In fact, the home tab ribbon in Excel looks
much like the one in Word for the first few sections.
So, to show something a bit different, I have displayed the Formulas tab Ribbon from Excel at the
bottom of this page.
As in Word, if you hover your cursor over one of the
icons in the ribbon, a small window pops up to describe the functionality of the item and also to give
you a keyboard shortcut, if such exists and if you
should want to learn that.
Also, just as I found with Word, all the documents
created with previous versions of the program
opened in the 2007 program without problems. I
was able to save the document in its “old” format, or
I could choose to convert it to an Office 2007 XML
format.

I suspect the new interface might actually be easier
for a novice user since they would not have to search
for features hidden in the old labyrinth of menus.
For me, though, it has taken a little time to get used
to it since, it is so different from the old interface,
but I am getting comfortable with it quite quickly.

One neat new feature is the zoom slider bar in the
lower right-hand corner of the Word screen, as
shown directly above. This makes it real easy to
zoom the document in or out.

(Office……….Continued on page 5)
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(Office……….Continued from page 4)

In my brief look at Excel, I could find nothing different about the functionality other than a larger and
more colorful selection of charts. The chart on the
previous page is an example of that. It is a Columnar
3-D Cone chart based on a pivot table created from
the membership renewal data for the club in 2002
and 2003. You might rightly ask why such old data.
Well, I keep the membership data for newsletter
mailings in Access—not Excel. But, for some reason, in looking for some Excel files with data to
graph, I found this old membership data already there
in Excel and thus used it to create the graph.
Excel 2003 does have a cone graph style; however,
in 2007 there are many more variations that can be
applied to it, one of which I used, so the workbook
containing the chart has to be saved in the Excel
2007 format.
Merle Nicholson alerted me to one improvement in
the new Excel—no limit of 65,535 rows in an Excel
sheet. Now you can have million-row sheets.
Outlook in appearance looks basically the same to
me as did the 2003 version. I see no Ribbon across
the top like the ones in Word and Excel. What I do
notice is that Outlook is now fully indexed so that
you get quick results for any text search of the messages. To get this going, Outlook first has to index all
your messages, which may take some time. But after
this, it indexes each new message that comes in, and
I gather that when a message is permanently deleted
its index information is also removed.
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Internet Picture of the Month

Postcard of old federal building in Tampa
From the Jacksonville Florida Public Library’s site,
http://jpl.coj.net/, we have one of the postcards
from their postcard collection. Their postcard collection at http://jpl.coj.net/dlc/florida/
postcards.html is divided into Jacksonville cards
and cards from the rest of Florida.
This card depicts the federal building and post office on Florida Avenue in Tampa. It must be fairly
old since it shows a horse carriage and no cars. The
card’s URL is http://jpl.coj.net/dlc/florida/pc/
PCJPG/PCJAX211-008.html.

One thing to note is that, as mentioned earlier, I have
both Office 2003 and Office 2007 installed on my
(Office……….Continued on page 6)

August’s Interesting World Wide Web Locations
Tampa PC Users Group (that’s us)
Stonehenge Aotearoa
W3 Schools—free web building tutorials
SunPass
Cyberhomes.com

http://www.tpcug.org/
http://www.astronomynz.org.nz/stonehenge/
http://www.w3schools.com/
http://www.sunpass.com/
http://www.cyberhomes.com

Some of these links will join the many already on the Links page at our web site, where you need only click on the name.
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(Office……….Continued from page 5)

computer. However, that is not totally true since I no
longer have Outlook 2003 installed—only Outlook
2007. You can have only one version of Outlook installed.
PowerPoint has the ribbon interface, and after getting
used to it in the previously-mentioned Office applications, it is straightforward and easy to use. Of course,
there are new templates for presentations, but, since I
do fairly unadorned presentations, it is hard for me to
tell what new or improved features this new version
has. One exception to that is something called Smart
Art on the Insert tab or the ribbon.
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ing with data stored in Access databases. I would say
that Access is Merle Nicholson’s primary area of work
at present. He sometimes presents some of what he
has been working on at our Access Special Interest
Group.
It was Merle mainly who caused me not to install Office 2007 over 2003 since he had found that some of
his applications created in Access 2003 did not port to
Access 2007. He uses custom tool bars in his applications, and the new Access Ribbon is not compatible
with them. Such things would not be a problem for
Access users who do not create custom applications.
At present, I have found none of my Access databases
that didn’t open and display properly in Access 2007.
I did, however, encounter one problem that was easily
fixed.
Many of my Access databases have Visual Basic code
modules in them. I found that when I tried to open
such databases and then do something like a query or
report that used this code, I would receive an error
message like Undefined Function Trim in Expression…….. In this instance, it was telling me it did not
know what the Trim function was (the VB function
that removes spaces before and after text). A check of
Google told me that it was a reference problem that
could be easily fixed by opening any code module,
displaying the references, adding any new reference at
random, closing the reference dialog and then reopening it and removing the recently added reference. And,
you know, I think I had this same problem when I installed Access 2003 and used the same technique to
fix it.

The types of Smart Art fall into the categories of
Lists, Processes, Cycles, Hierarchies, Relationships,
etc. The image above is a Cycle example.
Access is probably the least used Office application
and is, in fact, not even available in some of the distributions of Office. It is, however, the most powerful
and also most difficult to master of the applications.
You can make a good living programming Access applications. Of course, the same could be said for
Word if you used it to write Harry Potter books.
Much of my Visual Basic programming involves deal-

One new feature I noticed in Access and have tested is
the ability to create an email message in Outlook that
contains a form to collect information corresponding
to certain fields of an Access table. When I receive a
recipient’s reply to the email, what they entered in the
form’s fields is automatically inserted into a new record in the database table. This has possibilities for
questionnaires within our group.
I just about forgot to mention the program with which
I am creating the newsletter.
Publisher 2007 appears the same to me as Publisher
(Office……….Continued on page 8)
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Special Interest Groups
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Visual Basic for Applications SIG

Microsoft Access SIG

This SIG meets the third Wednesday of the month at 6:30 PM.
The meeting location varies. For information, contact William
LaMartin at lamartin@tampabay.rr.com.

This SIG meets the first Tuesday of the month at 6:30 PM.
The meeting location varies. For information, contact William
LaMartin at lamartin@tampabay.rr.com, or Merle Nicholson
at merle@merlenicholson.com.

Windows SIG

Digital Imaging SIG—Cancelled until further notice

(Minutes……….Continued from page 2)

Our presentation by Jim Purcell covered a multitude of
things related to digital imaging. Jim started off his
presentation by showing us a collection of film and
digital cameras that he has collected since the late
1940’s and early 50’s, giving us a little background on
why each particular camera was selected to be used by
him. For a little show and tell, Jim was able to connect
one of his digital cameras thru the room’s VCR to the
overhead projector, and, thus, we were able to see on
the screen what he could see when taking a picture,
including some of the settings and the changes made to
them. Jim demonstrated the differences in results by
varying the white balance settings. He also showed us
the differences obtained when choosing the bracket
shooting mode, whereby each of three pictures taken
sequentially have slightly different exposure settings,
allowing you to choose the best one. There was also a
discussion on the benefit of getting a digital camera
that had Image Stabilization capability, which can
eliminate photos that are slightly blurred due to movement in your hands and arm when taking a picture.

This SIG occupies the first 30 minutes of our monthly, regular
meeting and is devoted to a general Windows and computing
discussion. Bob LaFave moderates the discussion.

This is a correction to my article “Are CD’s and DVD’s
A Reliable Place To Store Your Data?”, that appeared
in the July issue of our newsletter. Lora Swenson, Sales
Manager of MAM-A Inc., graciously agreed to review
the article to make sure that I had reported their product
information correctly. I know that all of you are indeed
shocked to learn that I did make an error. She provided
the following correction to my article:
“The only correction that should be mentioned is
that MAM-A's Silver CD-Rs are estimated to last
conservatively 50+years under proper storage conditions, but Silver DVD-Rs are rated only for 20+
years. This is because DVD recordable discs have
two bonded plastic layers, which will allow oxidation
to occur for the silver metal layer over time, compared to CD-Rs that have only one plastic layer.
DVD-R dye is also not as UV resistant compared to
Mitsui's CD-R dye.
True archival discs should be 24K Gold, with accelerated aging tests for Gold CD-Rs rated at 300
years, and Gold DVD+/-Rs at 100+ years.”
— Jim Purcell

Jim next moved on to demonstrating photo corrections
that could be achieved using Photoshop Elements 4.0.
Through his familiarity with using this program, he
made it seem fairly simple to correct blemishes, coloring, red-eye, etc. in your pictures. This is a program
that he would like to demonstrate further in a future
Digital Imaging SIG, once that group’s meetings are
reinstated.
Jim brought to the meeting two different scanners that
he uses, and he demonstrated use of the Minolta film
scanner. He also had a flatbed scanner set up, but, due
to the lateness of the hour, he only mentioned some of
the ways he uses it. Jim concluded his presentation by
reeling off a list of books and publications that he rec-

ommended for a more in-depth understanding of the
world of digital photography and imaging. Unfortunately, I was not able to get that information written
down to include in these minutes, so I would recommend anyone interested in which books Jim has suggested to contact him directly to discuss the particular
topics that interest you.
The meeting concluded at the end of Jim’s presentation. We had a total of 26 members and guests present
at this meeting 

Tampa PC Users Group, Inc.
P. O. Box 3492
Tampa, FL 33601-3492

First Class Mail

Member: Your membership is up for renewal
Vendor: Your product was reviewed on page __

(Comments……….Continued from page 1)

view of them so soon after getting the 2007 versions
is that I really don’t have time to see what is new in
each program in any detail. However, I think there is
probably more interest in Office than in Photoshop.
Certainly more people have some version of Office
than they do of Photoshop (not to be confused with
Photoshop Elements). So that is what I will write
about this month and save anything concerning Photoshop for the future. 

(Office……….Continued from page 6)

2003. It does not have the Ribbon across the top,
but it has the usual menu bar and tool bars. I really
see nothing new, although I am sure that is not the
case and that there is at least a larger collection of
publication templates than before, if nothing else.
Groove, InfoPath and OneNote are the minor components of Office 2007 Ultimate. I have some interest in InfoPath and One Note and will possibly write
about them later. 

